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Rules video
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Caution

Please read carefully and follow these rules.

1.No outdoor shoes, food, or drinks in the lab.
2.Report equipment malfunctions to facility staff immediately. 
Emergency contact info is by the lab door.
3.Handle equipment with care.
4.Do not remove lab items without permission.
5.Manage your valuables. Lock the lab after use on holidays or 
at night.
6.When moving the stage, check the chamber carefully. 
Excessive movement may cause collisions with the X-ray source 
or other parts, leading to damage.
7.Restore software and hardware settings to default after use.
8.Do not connect personal USBs to the analysis PC. Use the lab’s 
USB via the dedicated PC.
9.Do not touch items in the lab with bare hands. Clean any tools 
you soil.
10.Reserve in advance and use the equipment during your time 
slot. Cancel reservations by the previous day. Same-day 
cancellations are invalid. For extensions, add reservations on 
the same day.
11.Your lab is responsible for equipment issues during use. 
Inform your supervisor about usage.
12.Contact staff and attend training before using equipment for 
the first time.
13.For reactive, large, fragile, or gas-emitting samples, consult 
staff before use.
14.Contact staff for permission before using a transfer vessel.
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Write your name and start time 
in the “logbook” and write finish 
time and parameters after using. 
Check the analytical chamber 
vacuum before use and write the 
value. Use as scheduled. Change of 
reservation on the day is invalid.

Check the Ar⁺ etching gun 
chamber vacuum and the 
analysis chamber vacuum. 
Normally,
✓ Ar⁺ etching gun ~10−4𝑃𝑎
✓ Analysis chamber ~10−7𝑃𝑎

If the degree of vacuum is 
significantly deteriorated, inform  
facility staff.

Ar⁺ etching 
gun chamber

Analysis 
chamber

Press the “Channel / float voltage” 
button on the ion gun unit to light 
it up and confirm that the display 
number is "7“.

The current and voltage conditions of the 
ion gun are input to each channel, and the 
ion gun is set by selecting the channel 
number. Channel "7" is a setting that does 
not use etching gun.

Ion gun unit

Before using
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Normal holder
(spare)

Normal holder

Holder for 
charged sample

Cover of Holder 
for charged 
sample

Large holder

Fastener Holder base

Remove the bottom plate 
of the holder when the 
sample is thick.

Make sure to clamp both sides of a sample. Set a sample 
does not move even if the holder is upside down. Pay 
attention to the positional relation  between the X-ray 
source and fastener & sample.

Sample preparation
Before starting up the equipment, set your 

sample onto the holder. Holders are stored 
in the vacuum desiccator. For standard 
samples, use the normal holder. A dedicated 
holder is available for larger samples (up to 
100 mm in diameter). If you are concerned 
about samples prone to emitting gas, fragile, 
or unstable, please consult with the staff.
Use Fasteners or carbon tape to secure the 
sample onto the holder. Ensure that the 
sample is completely fixed.

For Powder Samples
Attach the powder to the holder using 

carbon tape or press it onto a metal film 
(such as Al, In, or Si wafer). Use an air 
blower to blow off loose particles at least 30 
times to remove any powder that is not 
properly fixed. Additionally, apply light 
impacts or vibrations to the holder to shake 
off excess powder. Even a small amount of 
scattered powder inside the equipment can 
cause malfunctions.
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・Embedding Powder Using Indium (In) Foil
1. Cut two 3 cm square pieces of aluminum foil 

and one 1 cm square piece of In foil.
2. Place the In foil on top of one piece of 

aluminum foil and spread the powder sample 
flatly with a spatula, approximately the size of 
several spoonfuls, on top of the In foil.

3. Place the second aluminum foil sheet on top of 
the In foil and lightly press it with your fingers.

4. Hold the sandwich of aluminum foils carefully 
to prevent shifting, and place it on the black 
base of the press machine.

5. Put the other base plate on top of the sample 
and apply pressure with the hydraulic press 
(sufficient pressure within reasonable limits).

6. Release the pressure from the press machine 
and retrieve the sample.

7. Carefully remove the top aluminum foil without 
tearing it.Cut the sample, along with the 
aluminum foil and In foil, to the required size 
(around 5–10 mm square).

8. Using tweezers, gently remove any loose 
powder by applying vibration or impact.

9. Attach the sample to the holder and blow off 
any loose powder using a blower.

Release valve
Once the cylinder rises slightly, 
tighten it immediately.

Do not analyze areas where In foil is 
exposed. If the sample doesn’t adhere 
well, remake or change the fixation 
method. After preparation, secure the 
sample with a fastener or carbon tape. 
Too much sample will delay the 
vacuum process.

Sample preparation (Appendix)
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・For charge-neutralizing sample 
holder
The neutralization effect is enhanced by 

applying a bias voltage to the sample. By 
applying +100V to the sample’s bottom 
and creating a potential difference with 
the GND lid, neutralized electrons are 
efficiently directed to the sample surface. 
This also helps suppress surface potential 
shifts during Ar⁺ ion gun etching.

 Place the sample, close the lid, and 
secure it. The sample thickness should 
not exceed 1.3mm, and ensure the inside 
metal parts of the holder do not contact 
the lid. Make sure there is no electrical 
continuity between the lid and terminal 
parts after fixing, as continuity will 
prevent voltage application and nullify 
the effect.

・Surface Contamination of Samples
 To prevent surface contamination from air, samples created by dry processes should be immediately 
wrapped in aluminum foil or stored in a vacuum chamber to avoid exposure to the atmosphere. For 
samples made by wet processes, clean them with acetone, followed by ultra-pure water rinsing, 
thoroughly blow dry with air duster, and then wrap them in aluminum foil or similar material.

・Reference Peak for Samples
 To correct charge shift, it’s helpful to include a reference peak on the sample, especially if one is 
absent. For carbon-containing samples, the C1s peak may overlap with the sample's carbon, making it 
unsuitable. Use an Au thin film or mesh, or coat the sample with Au for measurement. For powders, 
mix in another powder with known chemical states, but be cautious as charge shifts may differ.

Sample preparation (Appendix)
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Set into the sample exchange chamber

1

2

VENT

Check 
with eyes

Vacuum gauge of sample 
preparation chamber

It takes about 30 minutes 
to achieve vacuum for 
small metal plate samples, 
while for powder samples, 
it takes over 2 hours. 
During the vacuum 
process, you can proceed 
with the equipment 
startup outlined on the 
next page.Wait more

Check 
no gaps

Magnet ring & Sample 
replacement rod

Don’t touch

Sample exchange chamber

Back of holder

Introducing the Holder into the 
Sample Preparation Chamber.
1. Unlock the door and press the VENT 

button to return the chamber to 
atmospheric pressure.

2. Slightly move the magnet ring forward 
to make the rail visible.

3. Place the holder horizontally on the rail, 
ensuring it is securely attached at the 
back.

4. Rotate the magnet ring on the sample 
insertion rod from "OPEN" to "CLOSE.“

5. Check that the hook is properly engaged 
by looking through the bottom.

6. Move the magnet ring back, close and 
lock the door. Press the VENT button 
again to restore the vacuum.  

Make sure the holder is properly set before continuing, as 
failure to do so will prevent the sample from being 
introduced into the analysis chamber.
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Turn on the chiller first. Next, press “SPEC” 
button and “X-R” button to light up.

The chiller power supply is always first. Pressing X-R button 
activate another chiller(you will hear motor sound). If the 
chiller is not running, press X-R again.

SPEC

X-R

Turn on the stage lamp, the camera power, 
the camera monitor, XPS-PC, and PC 
monitors. After starting the PC, click 
"SPECSURF Acquisition" on the desktop to 
launch the XPS software.

Stage lamp
Camera power

Camera monitor

CCD stage camera
Don’t touch

For analysis

Select “XPS” from the 
Acquire menu to open 
XPS acquisition window 
(if not, PC reboot)

Chiller

Startup equipment
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X-ray Setup

1. Choose the type of X-ray source to use
・Mg-Kα

About 40% stronger than Al-Kα. The Auger peak appears 
approximately 230 eV lower than the Al-Kα.

・Al-Kα
Can measure higher energy (B.E.) than Mg-Kα. The Auger 
peak appears approximately 230 eV higher than the Mg-
Kα.

・Monochromatic X-ray (Al)
Higher energy resolution than Mg-Kα/Al-Kα.  No satellite 
peaks, lower background. Intensity is about 1/10 of Mg-
Kα.The sample must be flat.

2. If using Mg Kα, light up the Al/Mg button; 
if using Al Kα, turn it off. For 
monochromatic X-ray, select Al and press 
the MONO/STD button to light it up.

3. Turn ON the FILAMENT power.
4. Slowly turn the ADJ knob to increase the 

current to 3.5A. And wait for 5 minutes 
after increasing.

5. Switch the display to "X-RAY POWER" and 
turn ON the X-ray power. Apply 3kV and 
5mA.

6. Increase the voltage by 1kV every 3 
minutes until reaching 10kV (for 
monochromatic X-ray, set to 12kV and 
wait for 30 minutes).

7. Increase the current by 5mA every 3 
minutes until reaching 10mA (for 
monochromatic X-ray, set to 25mA).

8. Finally, turn ON the Analyzer power.

Analyzer power

This is Al-Kα For monochrome

Startup equipment



Measure size left right

3.0mmφ 36 36

1.0mmφ 24 12

0.7mmφ 12 10

0.2mmφ 12 8

0.03mmφ 4 1 10

Select the Source tab from the 
SPECSURF XPS Acquisition. After 
entering the type of X-ray source, 
voltage, and current values, click 
"On" in the Status section.

Check the Automatic Off option to set the X-
ray to automatically turn off at the end of the 
measurement. This is useful if you tend to 
leave the system idle after measurements.

Once the Status changes to Update, 
press the AUTO/MANU button on 
the X-ray source unit to switch to 
AUTO mode.

If you wish to change the X-ray source settings 
later, return to MANU mode from AUTO.

Adjust the measurement range 
using the two apertures in the left 
image. Loosen the locking screws, 
then turn the aperture to the 
CLOSE direction to narrow or OPEN 
direction to widen the range, 
aligning it with the values in the 
table. For a setting of 36, fully open 
the aperture in the OPEN direction 
and adjust to 0.

Avoid over-rotating and turning in the wrong 
direction.
For comparing pre- and post-etching depth 

profiles, set the aperture to 1mm φ or 0.7mm 
φ. Use the 3mm & 1mm mode for 0.7mm φ.  
0.2mm φ and 0.03mm φ have poor sensitivity 

and cannot measure trace components.

screw
CLOSE

OPEN

Startup equipment
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Transfer into analysis chamber

1

2

3

The stage will fit in the groove 
on the back of the holder.

Move it to a position 
where it cannot move.

Turn the magnetic 
ring and pull it out.

Stage controller

Move the stage to the sample 
exchange position
1. Press the P/M button on the stage 

controller to switch to MEMORY 
mode.

2. Use the UP/DOWN buttons to select 
memory No. SE.

3. Press the MOVE button to move the 
stage.

The stage should already be at the sample 
exchange position, but always verify to ensure 
correct positioning.

Introducing the Sample to the Stage
1. Ensure the preparation chamber is 

sufficiently evacuated, then press the V1
button to open the partition.

2. Push the black ring on the introduction rod 
forward while monitoring the stage through 
the observation window, guiding the holder 
into the analysis chamber.

3. Once fully inserted, turn the ring to "OPEN," 
pull the black ring completely back, and 
press V1 again to close the partition.

If anything feels off, stop immediately and contact staff 
for assistance.
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Transfer into analysis chamber

Zoom up

Don’t touch camera 
body

Stage lever

After closing the V1 valve, check the 
vacuum level in the analysis chamber
•Above 5.0×10⁻⁶ Pa: Immediately retrieve the 
sample to the preparation chamber and continue 
pumping there.
•Below 5.0×10⁻⁶ Pa: Monitor the vacuum level in 
the analysis chamber until it stabilizes. If the vacuum 
deteriorates above 5.0×10⁻⁶ Pa, return the sample 
to the preparation chamber. Aim for a vacuum level 
below 1.0×10⁻⁷ Pa for optimal conditions.

Register Measurement Positions in 
Memory(For Mg-Kα/Al-Kα use only)
1. Move the stage to the desired measurement 

position using the stage lever. The 
measurement center aligns with the crosshair 
on the camera monitor.

2. Adjust the Z-axis value to focus the camera on 
the sample at the crosshair using the camera 
zoom(Lower the stage to account for the 
sample thickness).

3. Return the zoom to its original 
setting and verify the XY position 
is correct.

4. Switch to MEMORY mode by 
pressing the P/M button. Use the 
UP/DOWN buttons to select the 
desired memory number, then 
press ENT to register the position.

5. Repeat the process to register all 
measurement positions.
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Setting of monochrome X-ray(Appendix)

locking 
screw 

X-Ray Source 
Position Scale

Be careful not to 
accidentally touch 
other parts 

switcher

Ratemeter

After starting up the monochromatic X-
ray, perform the following three steps

Open the spectrometer crystal window
Loosen the locking screw of the switch 
in the center of the main unit, align the 
arrow from "baking" to 
"monochrome," and tighten the screw.
Retract the position of the Standard X-
ray source
 Turn the knob on the back of the main 
unit counterclockwise (when viewed 
from the rear of the device) and set 
the X-ray source position to 40mm.
Adjust the Z-axis of the stage using the 
Ratemeter
 Tilt the stage to -10° and move the 
sample to the analysis position. Close 
the XPS acquisition window, then open 
the Ratemeter window by selecting 
Acquire → Ratemeter. Enter the main 
peak value of the measurement 
element into Centre and click Start. 
Find the Z-axis value where the peak 
intensity reaches its maximum and 
register that position in the stage 
memory number.

Recommended settings( Pass/Ratio: 50 
Dwell: 400 Refresh time: 400 )
If the intensity is not sufficient, tilt the stage 

to -20° to improve measurement. Refer to 
the "Angle Resolved" high-angle 
measurement for releasing the tilt restriction.
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Set up the Ar⁺ gun when you want to remove contamination from the 
sample surface or measure the depth profile. Contact the staff when 
you use it for the first time.
 Use a measurement size of 1 mmφ or 0.7 mmφ. Ar⁺ etching may 
affect the chemical state and composition of the sample surface. The 
etching area is 3 x 3 mm centered on the camera display position.

After transfer the holder, wait until the vacuum in 
the analysis chamber is less than 10.0× 10−7Pa. 

Turn the valve 
at the back

Auto valve controller

Ar gas valve

Vacuum gauge of Ar⁺ gun

Setting of Ar⁺ etching gun(Appendix)

Press the AVC button on the 
ionization chamber vacuum gauge. 
Slowly open the Ar gas valve from 6 
o'clock to 9 o'clock. The vacuum 
gauge value will barely change until 
reaching 9 o'clock. Then, slowly
continue towards 7 o'clock.

Turn on the auto valve controller, the valve will 
close, and the vacuum reading will decrease.

SIP gauge

Keep gauge under 4

Micro-adjust the Ar gas valve to stabilize the 
pressure at 10.0×10⁻² Pa.  While opening, watch 
the SIP gauge (below the vacuum gauge) and keep 
its needle ≤ 4. If the SIP gauge exceeds 4, close the 
valve, then reopen slowly toward 10.0×10⁻² Pa. 
Wait briefly; if the pressure rises again, tighten the 
valve and readjust.

Do not exceed 12.5×10⁻² Pa (error threshold).
During analysis, check the SIP gauge regularly. If it 
approaches 4, pause the run, close the Ar valve to 9 
o’clock, wait for vacuum recovery, then resume.
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Press the Channel button on the Ion 
Gun unit and turn the X knob to select 
the etching condition. The conditions 
are as shown in the table below.
Etching rate is measured on SiO₂.

Select “Depth Profile” in Experiment tab, 
select Profiling tab, enter channel number 
to be used in Preset, enter Gas Pressure 
value in above table to Gas Pressure, and 
click Set.
 If you want to do Depth profile, go to 
"Depth profile" page.

Etching can be started by pressing 
“Irradiation ON/OFF” button in Ion 
Gun unit, and the elapsed time of 
etching will be shown on the display 
by turning on “Timer Display” (the 
time will be reset by pressing “Timer 
Reset”).

Setting of Ar⁺ etching gun(Appendix)

2025/7/18update

previous rate

9.0

channel Ch1 Ch2 Ch3 Ch4 Ch5

Beam energy(eV) 3000 2000 1000 500 3000

Emis current(mA) 20 20 20 20 20

Gas Pressure(x10⁻²Pa) 9.0 8.5 7.7 6.6 9.0

Etching rate(nm/min) 7.5 4.4 1.6 0.3 8.5

Etching rate(nm/min) 5.5 3.6 1.4 0.3 5.3
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In the case of non-conductive 
samples, non-uniform charging 
may occur on the sample 
surface. The non-uniform 
charging affects the energy 
value and the half width. The 
use of charge neutralizer can 
alleviate the charging 
phenomenon by supplying 
electrons to the sample surface.
It is recommended to use this 

when a powder sample contains 
both insulating and conductive 
materials.

Neutralizer unused Neutralizer used

Glass sample

・How to use charge neutralizer
1. Power on charge neutralizer 

unit
2. Press “SEL” button to 

change the ADJUST item to 
“FIL”. and turn the ADJ knob 
to increase the current 
value slowly to 6.0A.

3. Select Ratemeter from 
Acquire in the software 
menu. If XPS Acquisition is 
open, close it first.

Setting of charge neutralizer(Appendix)

charge neutralizer unit
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4. Enter the energy value of the highest 
intensity peak in Centre. Set Pass: 50, 
Dwell: 400, and Refresh time: 400.

5. Press Start and check the peak shape 
(if the peak is not visible, perform a 
wide scan to identify the peak 
position).

6. Turn on Acc.V. Press the SEL button to 
change ADJUST to Acc.V, then adjust 
the voltage using the ADJ knob while 
monitoring the peak count in 
Ratemeter. Find the voltage where 
the peak count is highest (if the peak 
increases at the screen edge, adjust 
the Centre value to center the peak). 

7. Once the voltage is found, fix the 
value, close Ratemeter, and proceed 
with regular measurements.

8. Perform a brief narrow scan under 
several electron gun conditions, 
compare the differences, and 
determine the optimal condition.

When using the holder for charged samples
Before setting up the neutralizer, turn on the 

device as shown in the left figure and apply 
voltage to the holder.

1. POWER On, and OUTPUT On.
2. Turn the current knob to apply a 

small amount of current.
3. Turn the VOLTAGE knob to set to 

100.0V.DC power supply device

Setting of charge neutralizer(Appendix)

Find the voltage value that results in not only 
the highest peak count but also normal peak 
position and peak full width at half maximum 
(FWHM). Determine the appropriate voltage 
value for each sample.
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✓ Always contact facility staff 
when using a transfer vessel. Do 
all work carefully.

✓ Do not give any shock to the 
transfer vessel. Make sure that 
there is no dust on the O-ring. Be 
careful when transferring the 
holder.

After fixing the sample to the 
holder in the glove box, mount the 
holder in the transfer vessel. Pay 
attention to the direction of the 
holder when mounting it (see the 
figure on the left). Turn the 
opening/closing knob to tighten it 
firmly.
Remove the lock of the sample 

preparation chamber door and 
remove the blank flange from the 
door after VENT.

Holder for transfer vessel

Transfer vessel

Do not touch the left part from 
here with your bare hands!

Fix the holder in this orientation.

Blank flange
Do not touch the inner part 
with your bare hands!

Opening/closing 
knob

Setting of transfer vessel(Appendix)
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Align the pins to attach the transfer 
vessel to the door and turn the fixing ring 
to fix it to the door. Lock the door and 
press the VENT button to evacuate. 
When the vacuum in the sample 

preparation chamber exceeds 
0.5×10⁻³Pa, carefully turn the 
opening/closing knob to open the vessel 
little by little. Opening the vessel too large 
will cause the pump to malfunction. 
Check the vacuum level and open the 
vessel carefully.

Fixing ring

When evacuate, push the 
vessel body in a little by hand.

Stop opening. Wait until 
the L lamp lights up.Open the vessel slightly.

Once the vacuum in the vessel is established, 
fully open the opening/closing knob. Operate 
the black ring to retrieve the holder, then 
close the vessel (but leave it slightly open). 
Once the vacuum in the sample preparation 
chamber is sufficiently established, open V1 

Setting of transfer vessel(Appendix)

and introduce the 
holder into the analysis 
chamber. Finally, close 
V1.
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Wide scan

There are a total of six different 
measurement methods. It is 
recommended to start with a wide scan 
for all measurements.
Select “Wide scan” in Experiment.

Select “None” for Movement to measure at 
the current stage position or select 
“Memory” to use the memory position of 
the stage controller.

Select the measurement size in Lens Mode.

Input the first number (First) and the last 
number (Last) of the memory number for 
continuous measurement in the Stage tab 
(when Memory is selected). Set each 
condition of Wide scan in Regions tab. 

Pass (eV) affects both energy resolution and intensity. A 
smaller value improves resolution but decreases intensity, 
with approximately 5 eV being the limit. The Step (eV) 
interval should ideally be set to about 1/100 of the Pass 
(eV) value. Scans can be adjusted based on 
measurements. The background noise decreases by 1/√N 
with the number of scans.
Recommended conditions for wide scans are as follows: 

Start: 1200 eV for Mg-Kα or 1400 eV for Al-Kα Finish: 0 
eV or -10 eV Step: 1.0 eV Dwell: 100 ms Pass: 50 eV 
Scans: 1–4 times

Click “Start” to start measurement 
and click “Check” to display the 
estimated measurement time.
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Markers

Use markers to identify the peaks that 
appear in the wide scan spectrum. Click 
Markers icon on the left.

A line will appear on the spectrum. When 
you put the line to the peak position, a list of 
elements will be displayed in “Suggested 
Peaks”. Select an element from the list and 
click “Add” to stamp the element name on the 
graph. And you can select from “Element” item. 
Some elements also have a Chemical Shift list 
that can be stamped as well. Clicking OK at the 
end will leave the stamp.

You can see the spectrum of the standard 
sample in the XPS handbook, so please refer 
to it.

The position of the marker is based on 
the standard, so it may be different 
from peak position of the actual sample.

Handbook 
icon

In addition to the photoelectron peak, various satellite 
peaks appear in the spectrum. In particular, the K-α₃,₄ 
satellites appear at 10 eV lower energy than the 
photoelectron peak. And when using Mg-Kα, Satellite 
peaks called "ghost peaks” derived from O-Kα(730eV 
higher), Al-Kα(230eV lower), Cu-Kα(320eV higher) appear. 
When using Al-Kα, same satellites appear.(960eV higher(O-
Kα), 230eV higher(Mg-Kα), 560eV higher(Cu-Kα)) 
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Narrow scan

Select region

After the wide scan, acquire spectra near the 
main peaks of each element in high-resolution 
mode for quantitative and chemical state analysis. 
Select “Narrow scan” in the Experiment menu.
 Refer to "Wide scan" for Movement and Lens Mode settings.

Set the memory number in the Stage tab (refer 
to "Wide scan" when using Memory). If the 
measurement content differs depending on the 
sample, you can group the samples here. Enter 
the group name in the Groups field and click 
Add. Input a set of numbers in “First” and 
“Last”, and select the name from “Group”.
Adding information in the Comment field is convenient.

In the example on the left, Memory No. 1 and 2 are registered 
under the Cr group, while No. 3 and 4 are under the PET group.

In the Regions tab, select “Group” 
and choose the element to be 
measured from “Element”.
Open the Wide scan spectrum and 
click the icon shown on the left. This 
will display the Start line and Finish 
line on the spectrum. Adjust the line 
positions to align with the peak, and 
the measurement range conditions 
will be updated accordingly.
Make sure to check this for all Wide scans.

Set the remaining parameters as 
appropriate (refer to the 
recommended conditions on the 
next page).
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Narrow scan

If you click “Pause” in “Acquisition Status”, 
the measurement will be interrupted after 
one scan, and only the number of scans can 
be changed. After changing, click “Continue” 
to restart the measurement. Pressing “Stop” 
will end the measurement after one scan 
cycle, “Abort” is force termination.

・About the spectrum window
 When the mouse cursor is placed on the spectrum, the energy 
position and intensity are displayed in the lower right of the 
spectrum window. In the upper left corner, there are icons to adjust 
the display scale. The spectrum obtained by continuous 
measurement is stored in one window. You can change the display 
of each sample, each region, and each level from the menu at the 
top right of the spectrum window.
 Save, Open, etc. of data are also done in each window. In the 
spectrum window, sample numbers are assigned from 0. Don't 
make a mistake with the sample number.

Scale icons
・Recommended Conditions for Narrow Scan
Start & Finish: Set the start and finish points at least ±10 eV 
around the target peak. Always verify that the entire measurement 
range can be covered across all samples.
Step: 0.1 eV or 0.05 eV. For Auger peaks, 0.2 eV is acceptable.
Dwell: 100 ms
Pass: 10 eV or 5 eV. For the measurement of minor components, 
set the pass to 20 eV, and adjust the step and dwell to 0.2 eV and 
200 ms. The FWHM will degrade by about 20% compared to 10 eV, 
but sensitivity will increase by 4 times. If performing relative 
quantification calculations, the pass and dwell should be 
consistent across all measurements.
Scans: 10–100 scans. 
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Depth Profile

By repeating the Ar⁺ etching and 
measurement alternately, the 
depth profile can be obtained. 
Contact the staff when you use it 
for the first time.
 
Select “Depth Profile” in 

Experiment and adjust Ar gas 
pressure of the etching gun (see 
“Setting of Ar⁺ Etching gun"). 
Select “Full” in Acquisition Mode. 

If you select “Separate” or “Simultaneous”, you can 
set the energy positions of Peak and Background and 
acquire only their differential intensities. Since no 
spectrum is acquired, the measurement can be 
performed at high speed. (See "Image & Linescan")

Set the etching time in “Profiling” 
tab. 
“Regions” settings are the same as 

"Narrow scan".
Etching changes the state of the 
surface potential and chemical 
state, and the peak position may 
move significantly, so you should 
measure a little wider.
Atomic mixing, selective 

sputtering, etc. may need to be 
taken into account in the analysis.

In the upper image, the etching time is 
set to 0 seconds before the first 
measurement (in the unit of level), each 
15 seconds before the second to fourth 
measurements, and each 60 seconds 
before the fifth to tenth measurements. 
The total etching time is 405 seconds.
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Angle Resolved
By measuring the spectrum while the 
stage is gradually tilted toward the 
analyzer axis, the depth profile of the 
sample can be obtained nondestructively. 
Contact the staff when you use it for the 
first time.
The stage can be tilted up to 80° to 
obtain a depth profile from 6 nm to 1 nm. 
A high tilt angle extends the area of the 
surface to be measured in the Y-axis 
direction, increasing the amount of signal. 
It can be applied to the analysis of minute 
amounts of components. 
The stage will be moved a lot, so please 
be very careful.  After analysis, be sure to 
restore the settings of both hardware and 
software. And, be sure to delete the 
positions registered in the stage memory.

・Setup of the XPS main unit
Transfer the holder to the analysis 
chamber. Be sure to fix the sample firmly 
as it will be tilted. Loosen the locking 
screw and turn the micrometer of the 
magnetic lens stage to lower it from 
Z=17.95 to Z=8.5. Make sure the switch at 
the bottom is pressed (you should hear a 
small click. Be careful not to lower it too 
far or it will break). Tighten the loosened 
locking screw again.  

Magnetic lens stage

Magnetic lens

Locking screw

Switch

Micrometer of the 
magnetic lens stage
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Angle Resolved

・Setup in Spec Surf software
Go to "View" -> "Configuration" to launch 

"System Configuration", and select "High 
Angle" for "Sample Holder". the tilt limit will 
be released, allowing you to move the stage 
from -30° to 80°. After that, please 
operate the stage with great care. If you only 
want to do wide and narrow scan at high 
angle, you can continue as usual.

Select "Angle Resolved" in the 
Experiment tab, and set the tilt angle of 
the stage in the Profiling tab. In the left 
picture, XPS acquires spectra at each 
level while tilting from 0° to 80° in 
5° steps. If you want to tilt the stage 
more than -10°, be sure to move the 
position of the X-ray source back by 5 
mm (see "Setting of monochrome X-
ray").For the rest of the settings, refer to 
"Wide Scan" and "Narrow Scan". 

← If the holder is tilted in the 
minus direction, there is a risk 
of it hitting the X-ray source. 
Basically, it is prohibited. 
Please consult with staff.

Configuration
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Total Reflection

Total Reflection uses monochrome X-rays, and 
by adjusting the position of the stage so that 
total reflection of X-rays occurs, it is possible to 
obtain spectra that are about two-thirds 
shallower than the normal measurement depth, 
and with a better signal-to-noise ratio due to the 
no penetration of X-rays. It is mainly used to 
evaluate contamination on the surface of a 
sample. Only samples with smooth surfaces 
(such as Si wafers) can be measured. Contact the 
staff when you use it for the first time.

・Measurement Method
1. Place the sample in the holder so that 

the sample surface is parallel to the 
stage, and transfer the holder.

2. Set up the monochrome X-ray and 
adjust the Z position while checking the 
photoelectron spectrum of the sample 
with Ratemeter (see " Setting of 
monochrome X-ray ").

3. Select "Total Reflection" in "Experiment", 
tilt 0.2° from -10° to -5°, and 
acquire the spectrum, and check the 
tendency of the signal-to-noise ratio. 
(see " Setting of Total Reflection")

4. Check the spectrum with Ratemeter by 
1° from -4° to -1°, and fine adjust Z 
again to get the intensity.

5. After the Z adjustment, measure at the 
angle with the best S/N ratio. Basically, -
1°.

Wide   BE (eV)
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20140328_133719_Wide_
20140328_132916_Wide_

Normal wide scan  Total Reflection scan
You can see that the intensity of the 

contamination C1s peak is about twice 
as large as in the normal measurement. 

C1s

O1s

Si2p

O 1s  BE (eV)
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500
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check the tendency of the 
signal-to-noise ratio. 
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Image & Linescan
Image can obtain elemental mapping 
images up to 5.0 x 1.8 cm in size. If 
chemical shifts are available, it is 
possible to map the distribution of 
oxides and metals, for example. Contact 
the staff when you use it for the first 
time.

First, obtain a Narrow scan of the 
element you want to measure. Select 
"Image" in "Experiment", and select 
"Separate (PB separate method, easy to 
set up)" or "Simultaneous (PB 
simultaneous method, fast 
measurement)" in "Acquisition Mode".

・Separate
 Set the values of Peak, Bk1, and Bk2 
based on the spectrum of Narrow scan 
acquired in the Regions tab. Only the 
intensity at that energy positions are 
acquired.
・Simultaneous
 Click the Channels column and select 
whether the intensity to be acquired by 
each channel (detector) should be 
Background or Peak. Change the Pass 
value appropriately so that the high 
energy side Background, Peak, and low 
energy side Background of the element 
to be measured.

Separete

Simultaneous

Bk1Bk2

Peak

Acquire the intensity at each energy 
position with 9 detectors, and subtract 
the background intensity from the peak 
intensity to draw the mapping.
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Register the upper-left stage position to 
memory No.1 and the lower-right stage 
position to memory No.2 of the sample 
area for which you want to acquire the 
image using the stage controller.

No.1

No.2

Mapping area

In the Image tab, click "Read" to 
read the memory positions." In 
Scan, select either Size or Step and 
set the resolution of the image. For 
"Mode", select "Image".

←Mapping image obtained by "Image". red:Si
and blue:Au. The image of each element in the 
mapping result can layered in different colors.

Image & Linescan

Select "Linescan" 
for "Mode" to 
perform line profile 
from memory No.1 
to No.2 position.

Si peak
(SiO₂)

Si peak 
(Si)

←Linescan results by 
Simultaneous method. This is a 
Si wafer etched with Ar⁺ in 
the center.

Si(SiO2)

Si(Si)
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Saving data
All measured spectrum data are 
automatically saved with the name of 
the date, measurement method, and 
X-ray source  in “Auto Storage” folder.  
Select the Auto Storage folder from 
"File" -> "Open", select the data, the 
details of the data will be displayed at 
the bottom of the save window.
To save the spectrum in a different 
format, select “File” -> “Save as” and 
choose the file type. In addition to 
SpecSurf data, text format and VAMAS 
format can be output.

For users who have indicated "Yes" for data 
provision in the ARIM usage application 
form, please ensure to save and take the 
data in VAMAS format. This will be used for 
data upload.

You can output the spectrum as an 
image in report format by clicking 
"File" -> "Report". Quantification 
results and waveform separation 
results can also be compiled into a 
report.
If you want to keep the data on this 
XPS-PC, please save them in a folder 
“data”. Please keep a folder for each 
laboratory.
Basically, please bring back the 
measurement data by yourself. We 
cannot guarantee the preservation of 
the data.

Report image

Title      : 20241112_152022_Narrow_AlKa_cc_bs.ssf
Date       : 火曜日, 11月 12, 2024
Operator   : XPS User
Institute  : UnKnown
Technique  : XPS
Source     : x-ray (AlKa)
Lens Mode  : DHA : Preset No.0
Experiment : Narrow scan
Movement   : Memory
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Element Region Start (eV) Finish (eV) Step (eV) Dwell (ms) Pass (eV) Scans
O 1s 539.463 524.463 0.100 100 10 20
Ca 2p3/2 357.463 341.463 0.100 100 10 20
C 1s 293.463 278.463 0.100 100 10 20
Si 2p3/2 107.463 93.463 0.100 100 10 30

Element State Label Sensitivity Intensity (cps) Atomic %
O 1s O 1s 11.9121 23743.40 59.42
Ca 2p3/2 Ca 2p3/2 21.1321 13182.72 18.60
C 1s C 1s 4.2584 688.43 4.82
Si 2p3/2 Si 2p3/2 3.5266 2029.57 17.16

Co 2p3/2  BE (eV)
805 800 795 790 785 780

2280
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2440

Energy Intensity Width/2 Area Ratio
780.83 70.0057 1.80713 279.896 71.7748
785.262 22.2201 1.21626 60.1004 15.4118
787.556 16.5581 1.35822 49.9675 12.8134
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End procedure
・ Using the holder for charged samples

Return the voltage and current values of DC power supply device to 0.
OUTPUT OFF.
POWER OFF.

・ Charge neutralizer
Return the voltage and current values to 0.
Acc.V OFF.
Unit Power OFF.

・Using Ar⁺ etching gun
Auto Valve Controller OFF.
Close the Ar gas valve clockwise to about 9 o'clock (1/4 turn). 
Wait for 3 minutes.
Close the Ar gas valve clockwise to about 6 o'clock (3/4 turn).
AVC of Ar⁺ etching gun chamber vacuum gauge OFF.
On the ion gun unit, select "Timer Display" and press the "Timer Reset" button.
On the ion gun unit, select "Channel" and turn the X knob to reset it to "7."

・When Angle Resolved measurement carried out
Move the stage to the sample exchange position.
Return the X-ray source position to 45mm(if it has been changed).
Return the Z-axis of the magnetic lens to Z=17.95 and retighten the locking screw.
Reset the holder setting in “Configuration” to “Standard”.
Delete all position registered in the stage memory.

・ Using monochrome X-rays 
Move the stage to the sample exchange position.
Return the X-ray source position to 45mm.
Return the switcher device to “Baking” and tighten the locking screw.
After 15 minutes have passed since you performed the “X-ray shut down" 
procedure on the next page, press the "MONO/STD" button to return to "STD". 
If the stage tilted above -10 °, perform the procedure described in “When Angle 
Resolved Measurement carried out”. 

・When using the transfer vessel
Return the holder to the sample preparation chamber, re-seal the holder in the 
transfer vessel.
Unlock the door and VENT. After VENT, remove the transfer vessel and reattach 
the blank flange to the door.
Lock the door and draw a vacuum in the sample preparation chamber. 

If you have any of the following uses, please 
perform the following end procedure before 
the normal end procedure.
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・X-Ray shutdown
Press “Auto/Manu” button to change to “Manual”.
Reset X-Ray current to 5 mA and voltage to 3 kV.
Turn off X-Ray power.
Change the display to show “FILAMENT POWER”.
Turn the ADJ knob of FILAMENT to set the current back to 0.
Turn off FILAMENT power.
Click “Off” in the Source tab of XPS acquisition in Spec Surf.

・ Take out the holder
Press the P/M button on the stage controller to change to MEMORY mode.
Press UP and DOWN buttons to display No.SE.
Press the MOVE button to move to the sample exchange position.
Press the V1 button to open the V1 valve.
Turn the magnetic ring to the “OPEN” position and push it forward.
Turn the magnetic ring to the “CLOSE” position.
Pull the black ring out to the end and return the holder to the sample exchange 
chamber. Press the V1 button again to close the V1 valve.
Open the lock of the sample exchange chamber.
Press the VENT button to return the sample exchange chamber to atmospheric 
pressure. Turn the magnetic ring to “OPEN” and take out the holder.
Lock the sample exchange chamber and press the VENT button to draw vacuum.

・Finish XPS equipment & other tasks
Remove the sample from the holder, clean the holder, and place it in the vacuum 
desiccator to draw vacuum. Clean up the workbench.
Turn off analyzer power HT.
Turn off the camera, camera monitor and stage lamp.
Transfer measurement data to PC for analysis using the USB memory of this Lab.
Shut down Spec Surf, PC and turn off display.
After 15 minutes from X-ray shutdown (when using monochrome X-ray, switch 
MONO/STD to STD), turn off the X-R and SPEC buttons.
Turn off the power of the chiller.
Enter the vacuum level of the analysis chamber and the end time in the logbook. 
When using the laboratory at night, turn off the lights and lock the door.

This is a common procedure for all measurements. Please be sure to 
follow the procedure.

End procedure
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Q & A
In principle, please consult with the staff.

•V1 does not open even after pressing the V1 button
→ Push the black ring of the sample introduction rod all the way back. If the 
secondary pressure of the nitrogen cylinder has dropped to 0, the cylinder needs 
to be replaced. Please contact the staff.
•The vacuum is not progressing or the vacuum level is poor
→ Check for debris on the O-ring of the sample preparation chamber door. If the 
issue is due to the sample, try reducing the number or volume of samples as 
much as possible. If heating is possible, heat the sample to remove moisture 
before introducing it. If the vacuum level does not improve, you may have to 
wait. Please complete as much preparation as possible to ensure the sample is 
dry.
•No signal is detected even after starting the measurement
→ Check the HT button, verify the aperture value in the measurement range 
settings, and confirm the status of the monochro/standard button on the X-ray 
source. If the wrong X-ray source is selected, turn off the X-ray, wait 15 minutes, 
and then restart with the correct source.
•The peak intensity of the target element is too weak to perform a narrow scan
→ Reassess the sample, review the sample mounting method (e.g., embedding 
in In foil), check the analysis position, and confirm the peak position. Adjust the 
measurement conditions to a pass of 20 eV, dwell time of 200 ms, and step of 0.2 
eV, and increase the number of scans as much as possible. Note that energy 
resolution will decrease.
•P-H error is displayed on the vacuum gauge after opening the Ar gas valve
→ The valve was opened too much. Turn off the auto valve controller, rotate the 
Ar gas valve clockwise one turn to return to its original position, and press the 
"MEAS" button on the vacuum gauge of the Ar ion gun to clear the error. Then 
press the "FIL ON" button to restore the display. Open the Ar gas valve slowly 
and carefully this time.
•Unknown peaks appear, or the spectral shape looks abnormal
→ If contamination is not suspected, try using the neutralizing electron gun as 
the issue might be due to charging. Additionally, try changing the type of X-ray 
source and remeasure. If the peak disappears, it may be caused by an Auger 
peak or ghost peak.
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